Basic Unsteady Flow Modeling
Workshop

1 Objective

In this workshop, you will exercise your knowledge on the basics on unsteady flow
modeling to setup and compute a simulation for Bald Eagle Creek, PA. The workshop
consists of the following major tasks:

Creating an Unsteady Flow file and adding boundary conditions
Linking boundary conditions to DSS data

Setting initial conditions

Performing a sensitivity analysis on boundary conditions
Revieing results using various methods

2 Background

You will be working with a dataset for Sayers Dam on Bald Eagle Creek in central
Pennsylvania. Sayers Dam is approximately 15 miles upstream of the town of Lock
Haven, which is protected by a levee system. See the figure below to become
acquainted with the dataset.

Marsh Creek

Fishing Creek

Beech Creek

Sayers Dam
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3 Setup Unsteady Flow Boundary Conditions

1. Start HEC-RAS and Open the "Bald Eagle — Unsteady” project

2. Open the Geometric Data editor to become familiar with the data. Identify
areas of interest such as Lock Haven, Sayers Dam and the tributaries using
the figure above.
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3. Open the Unsteady Flow Data editor

File Edit Run View Optio s Help
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a. Notice that at a minimum, the this geometry requires an upstream,
downstream, and inline structure boundary condition.

A Unsteady Flow Data - m] X
File Options Help
Description: | D R

Boundary Conditions | Initial Condiﬁonsl Meteorological Datal Observed Data]
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Add Boundary Condition Location

AddRS... | AddSA/DFlowArea... | AddComn... | addpur | Add Pipe Node ... |
River Reach RS dary Condition
1|Bald Eagle Cr. Lock Haven 137520
2|Bald Eagle Cr. Lock Haven 81454 IS
3|Bald Eagle Cr. Lock Haven -1867
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4. Select File, Save Unsteady Flow Data. Name flow file "PMF-HMS".

5. Set the upstream boundary condition at River Station "137520” to a Flow
Hydrograph. This boundary condition will represent the reservoir inflows.

File Options Help

Boundary Conditions | Initial Conditions | Meteorological Data | Observed Data |

Select Location in table then select 'oundary Condition Type

1|Bald Eagle Cr. Lock Haven 137520 ' " |
2|Bald Eagle Cr. Lock Haven 81454 IS
3|Bald Cr.  |LockHaven -1867

6. When the Flow Hydrograph editor opens, select Read from DSS before
Simulation Option.

Flow Hydrograph
River: Bald Eagle Cr. Reach: Lock Haven RS: 137520
|~ Read from DSS before simulation | Y A R AR Bat
File: |
Path: |

7. Click Select DSS File and Path button.

Flow Hydrograph
River: Bald Eagle Cr. Reach: Lock Haven RS: 137520
" Read from DSS before simulation T Relect D5S e and Path Y
File: |
Path: |

8. Click the Add File button and select the DSS file in the “Flow__Data"”
directory as shown below.
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River: Bald Eagle Cr. Reach: Lock Haven RS: 137520: Flow — O X

File Options Help

~ File Count: 0 Time Window: Invalid Time Window

Ei Use FileName FileDate Time Window

[Plan Time -

General Filter: I &3 open X
Last Applied Filter: « ¥, ¥ “ W - Unsteady... > Flow_Data v D £ Search Flow_Data
Rovid File Name Type PartA Pa Organize - New folder = T3 o
ow Y N
]7 EJ I_LH ‘I_LH [ = Pictures A Name Dista aifiad Tigh
M Videgs | | HMS_Flows-BaldEagle.dss 4/26/2022 4:28 PM DSS F
2 1 0SDisk (C)
«% DATA (D3)
w «M_Drivia Nhar_n M X >
v Show Plot
Selected Path: File name: |HMS_Flows-BaldEagle.dss ~ | DSS files (*.dss) v

Open & Cancel

a. This DSS file contains results from an HEC-HMS hydrologic model. You
will add those results as boundary conditions to this model.

9. Select the pathname with the "SAYERS INFLOW" B-Part and select OK.

Cr. Reach: Lock Haven RS; 13

File Options Help
~ FileCount: 1 Time Window: 01Jan1999 1200 - 04]3;1:}9992400

&I Use FileName Fi Time Window
E ﬂ ‘C:\Unsteady'l D\2018 Class Materials\Working\Unsteady Flow\Fresh_Start\Flow_Data\HMS_Flows-BaldEagle.c | 4/ 1S :| Plan Time LI
General Filter: | Apply
Last Applied Filter: Path Count: 6/6
R File Name Type Part A Part B Part C Part D PartE PartF Data Type Data Units
ow I 1 1Y,z
I =] [timeseries =1 [=]] | = =) || = =] | =T | [
1 HMS_Flows-BaldEagle Regu!arT\meSerles_ BEECH CREEK FLOW FLOW 0‘\ DEC1998-01JANTS99 15MIN | PMF-EVENT INST-VAL | CFS
2 HMS_Flows-BaldEagle RegularTimeSeries | FISHING CREEK FLOW _01DEC199870UAN1999 | 15MIN | PMF-EVENT INST-VAL | CFS
2 HMS_Flows-BaldEagle RegularTimeSeries LOCAL DOWNSTREAM OF DAM | FLOW | 01DEC1998-01JAN1899 | 15MIN | RUN:PMF-EVENT INST-VAL | CFS
4 HMS_Flows-BaldEagle RegularTimeSeries MARSH CREEK FLOW |01DEC1998-01JAN1999 15MIN | PMF-EVENT INST-VAL | CFS
5 HMS_Flows-BaldEagle RegularTimeSeries RESERVOIR LOCAL FLOW | 01DEC1998-01JAN1939 15MIN RUN PMF-EVENT | INST-VAL

6 HMS_FI(lws-BaIdEaéle RegularTimeSeries |SAYERSINFIOW ~ [FLOW |O1DEC1998-0TJANT399| 15MIN PMF EVENT INST-VAL LFS ‘

~ Show Plot

Selected Path: //SAYERS INFLOW/FLOW/01DEC1998-01JAN1999/15MIN/PMF-EVENT/ OK I Cancel |

10. Select OK in the Flow Hydrograph editor to accept the changes.

11. Set the downstream boundary condition at River Station "-1867" to Normal
Depth. Use a Friction Slope of 0.0005.

12. Set the Inline Structure boundary condition at River Station 81454 IS”
to T.S. Gate Opennings.

a. Change the Data time interval to 1 day. Enter 1 ft in the table
through 06 Jan as shown below. Click OK.
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Gate Openings

River: Bald Eagle Cr. Reach: Lock Haven RS: 81454
Gate Group: Gate #1 MRk
" Read from DSS before simulation Select DSS file and Path ]
File: |
Paih:l

{* Enter Table Data time interval: |1 Day - l

| Select/Enter the Data's Starting Time Reference
| & Use Simulation Time: Date: | Time: |
| € Fixed Start Time: o _I Time:

No. o-dnams| Interpolate Missing Values ] Del Row | Ins Row j

Hydrograph Data

Date Simulation Time | Gate Opening Height
(hours) (ft)

1 0:00:00 i

2| 01Jan0100 2400 24:00:00 1

3| 02Jan0100 2400 48:00:00 i

4| 03Jan0100 2400 72:00:00 1

5| 043an0100 2400 96:00:00 1

6| 05Jan0100 2400 120:00:00 1

7| 06Jan0100 2400 144:00:00 1

8| 07]Jan0100 2400 168:00:00

9| 08Jan0100 2400 192:00:00 -

PotData | ok | Cancel |

a. At this point, the Unsteady Flow Data editor should look like the

figure below.

'_}! Unsteady Flow Data - PMF-HMS

File Options Help

Description: [

Initial Conditions | Meteorological Data | Observed Data |

Stage Hydrograph | Flow Hydrograph | StageflowHydr. |  RatngCuve |
NormalDepth | | ST sfiow | Groundwater Interfiow |
2 |

|

| u
| Navigatien Dan | B Stane/Flow
|

cfplkation

addRs... | addsa/mriowarea.. | addcomn.. | adipumo s | addPpenode.. |
River Reach RS Boundary Condition

1|Bald Eagle Cr. Lock Haven 137520 Fiow Hydrograph

2|Bald Eagle Cr, Lock Haven 81454 IS |T.S. Gate Openings

3|Bald Eagle Cr. Lock Haven -1867 Normal Depth

14. Next you'll create additional boundary conditions for the tributary inflows.

a. In the Unsteady Flow Data editor Select the Add RS... button.

13. In the Unsteady Flow Data Editor select File | Save Unsteady Flow Data

b. Select the 3 rivers stations where tributary flow will enter the model.

River Stations: 76865, 67130, and 28519
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File Options Help

ﬁ_\ Unsteady Flow Data - PME Event from HMS

Description: ]

Boundary Conditions | Initial Conditions | Meteorological Data| Observed Data |

Boundary Condition Types

e

Add SA/2D Flow Area .. |

Add Boundary Condition Location

| Add Pipe Node ...

Selected Locations

Node Types...

ion Boundary Locations

Selected Locations

(3 selected)

Bald Eagle Cr. Lock Haven
Bald Eagle Cr. Lock Haven

76865
67130

River: |Bald Eagle Cr.

~| IBald Eagle Cr. LockHaven 28519

Reach: fLod: Haven

RS: 35393
35300 LS
33911
32863

=

-~

c. Set each of the new locations to a Lateral Inflow Hydrograp
boundary condition and select the appropriate DSS File and path
for each location as indicated below:

River Station

DSS B-Part

76865
67130
28591

4 Set Initial Conditions

MARSH CREEK
BEECH CREEK
FISHING CREK

15.1In the Unsteady Flow Data editor, switch to the Initial Conditions tab.

A Unsteady Flow Data - PMF-HMS = ] X
File Options Help
Description: I _] —,
Boundary Conditions :7 Meteorological Data | Observed Data

Initial Flow Distribution Method

" Restart Filename: | _I

" Prior WS Filename: | 2

Profile: ;I
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16. Set the initial flow at the cross-section just downstream of the dam

a. Select Add RS... and ad, River Station 80916.

5. Unsteady Flow Data - PMF-HMS — O X

File Options Help

Description: |

Boundary Conditions  Initial Conditions I Meteorological Data | Observed Data

Initial Flow Distribution Method Initial Condition Flow Locations
" Restart Filename: Selected Locations
Selected Locations (1 selected)

" Prior WS Filename: Node Types... | Bald Eagle Cr. Lock Haven 80916
River: |Bald Eagle Cr. -
% Enter Initial flow distribution (Optior| | peach: [Cock Haven =

Us: 80720

| |River [Reach a;ggg;

1|Bald Eagle Cr. Lock Haven 79463 BaldE. atBlz
78936
78247

77815
77379

76865

75908 Marsh Creek
74651

74120

73035

72156

71394

70531

69539

68146

67130

66041 BeechCr. Cc
65501

54400 v

m

Clear Selectedlist | ok | cancel |

b. Then set the Initial Flow to 900 CFS. This will represent the initial
outflow from the dam.

File Options Help
Description: | I
| Metearological Data | Observed Data |

Profile: [ _;]_
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17. Next, add an Initial Stage to represent the starting pool elevation.

a. In the Options menu select Internal RS Initial Stages...

A Unsteady Flow Data - PMF-HMS = O X

File Options Help

Desa Delete Initial Flow(s) From Table ... I ~ _J
Bou DSS Pathname Summary Table ...

Apply Data

=d Data |
Boundary Condition Names ...

j

Internal RS Initial Stages ... N |
Flow Minimum and Flow Ratio Table ...
Observed (Measured) Data >

»

e

b. Find RS 81914 in the “"River Sta.:” dropdown and select Add an
Initial Stage Location.

Unsteady Flow Data - Initial Stages ‘

River: |Bald Eagle Cr. | Delete row(s)... | ”
Reach: [rockFaven ] e st

Locations and Initial Stages

c. Set the starting elevation to 657 ft, the spillway crest elevation, and

press OK.
Unsteady Flow Data - Initial Stages
River: |Bald Eagle Cr. | Delete row(s)... | Add mutiple... |
Reach: |Lock Haven ] River sta.: [81914 v|  Addan Initial Stage Location |
Locations and Initial Stages ‘
River Reach RS Elev
1|Bald Eagle Cr. Lock Haven 81914 657

o ] conce

18. Save and close the Unsteady Flow Data editor.
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5 Create a Plan and Compute

19. Open the Unsteady Flow Analysis editor.

File Edit Run Vi ptio Tools Help

(8| o | =] el A[Eal5 (S

20. Enter the Programs to Run, Simulation Time Window, and Computation
Settings as shown below:

N
*| -|F A e

B I e[|

'_;! Unsteady Flow Analysis

File Options Help
Plan: PMFEvent ShortID: [PMF-Event
Geometry File: IExis'ang Conditions L]
Unsteady Flow File: lPl-F-H?-'IS ;I
Programs to Run Plan Description
[¥ Geometry Preprocessor
¥ Unsteady Flow Simulation
[~ Sediment
¥ Post Processor
I Floodplain Mapping
Simulation Time Window
Starting Date: 01Jan 1999 J Starting Time: [1200
Ending Date: osdanisss | g Time= [poon
Computation Settings
Computation Interval: 1Minute  ~| __.I Hydrograph Output Interval: Es Hour - I
Mapping Output Interval: 6 Hour d Detailed Output Interval: Eé Hour - I
Project DSS Filename: ﬂ IC :\Unsteady 1D\20 18 Class Materials\Working\Unsteady Flo' E
Compute |

Note: The 6 hour output intervals will be changed again later in the workshop.
21. Save the Plan and call it "PMF-Event”.

22.Compute

6 Reviewing Results

23.0pen the Cross-Section Plot and the Profile Plot. Arrange them side-by-
side on your screen.

File Edit Run View Options GISTools Help
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24.1n the Cross Section Viewer, display River Station "81454 IS Joseph
Sayers Dam”

25. Launch the Animation Control and advance through the profiles and answer
the questions
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Question: Which profile (date and time) had the highest water surface
elevation at the dam and what was it?

Question: What is the water surface elevation at the dam for the "Max
WS” profile? What is the difference in from the answer above?

26.0pen the Stage & Flow Hydrograph Viewer

File Edit Run View Options GISTools Help

seo |

| V|

=| v ¥ 7 [e[nly| | B|E| 0

|6 e[

~HP)
el

S| E|Als

27.From the Type menu select Inline Structures to view the hydrographs for
the dam.

Question: What is the maximum water surface elevation and
maximum total flow for the dam? Comment on the shape of the
hydrographs.

28.In the Unsteady Flow Analysis editor, go to File | Save Plan As ... and
call the plan PMF-Event-New. Change the output intervals to 30 min.

29.Recompute

Question: Now that we’ve decreased the output interval, how do the
stage and flow hydrographs compare to the previous run?

Question: Similarly, how does Profile Plot compare to the previous
run?
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7 Revieing Results in RAS Mapper

30.Open RAS Mapper

File Edit Run View Options GISTools Help

@ || e | o] $lo| £ Alx |2 [ |H 2| @|n o | B8]

31.From the Project Menu select Set Projection and navigate to the
projection in the GIS_Data directory.

= e - 2> - E
_ irka
Frvject Seings. Coordinate Reference System \ B
Projection ‘ irka
Projection File: | @ —_
General
Definition;

Render Mode =
<+ Browse for the coordinate reference system file for this project
Mesh Tolerances

Global Seti v l Working Unsteady Flow > GIS_Data
General Organize « New folder
RAS Layers Name Date modified Type
Map Surface Fill M projection.pij 1/7/2016 11:13 AM PRI File

32.Right-click on "Terrains” in the tree and select Add Existing RAS Terrain.
a. Navigate to the “Terrain.hdf” file in the “"Terrain” directory.

33. Expand the “"Results” node in the tree and turn on the “"Depth” layer.
Use the Animation Toolbar to visualize the flood wave move

downstream.
RAS Mapper - o x
File Project Tools Help
HOAx X € ENS MO M v d e~
[] Features Results 04JAN1999 00:00:00

=[] Geometries
Existing Conditions
[] Event Conditit
= [V] Results
[=)- [¥] PMF-Event
[] Event Conditions
] Geometry
Depth (04JAN1599 00:00:00) [N
] Velocity (01JAN1999 12:00:00)
[ WSE (01JAN19S9 12:00:00)
- [¥] PMF-Event-New
[] Event Conditions
] Geometry
Depth (04JAN1959 00:00:00) (TR
[ Velocity (01JAN1999 12:00:00)
] WSE (01JAN1999 12:00:00)
~[IMapLayers
=[] Terrains

9] Terrain = a

M Views | Profile Llnesl Active Featuresl‘ |

(2081903.72, 290042.58 1 pixel = 185.38 ft)

34.1In Mapper, animate the Depth layer again to see the impact of the output
interval change.
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35. Turn on the Velocity Layer and Select the Max button in the animation
toolbar.

Question: Locate 3 areas where velocities are the highest. What
are the velocities in these areas? What do you think is causing the
high velocities?

8 Downstream Boundary Sensitivity

36. Open the Unsteady Flow Data Editor, and select File | Save Unsteady
Flow Data As.... Name the Unsteady Flow Data as "PMF-HMS_0001".

37. Reduce to Friction Slope on the downstream boundary condition to 0.0001.
38. Save the new Unsteady Flow File.

39. Create a new Plan using the File | Save Plan As.... in the Unsteady Flow
Analysis editor.

a. Name the new plan “PMF-Event_FS_0001"

b. Ensure the plan is using the new Unsteady Flow Analysis file

!;! Unsteady Flow Analysis

File Options Help b
Plan: PMF-Event_F5_0001 ShortID: |PMF-Event_F5_0001
Geometry File: [Exist:ing Conditions ;I
Unsteady Flow Fie: >
Programs to Run | -~ Plan Description 1

¥ Geometry Preprocessor

¥ Unsteady Flow Simulation
I Sediment

¥ Post Processor

I Floodplain Mapping

40. Save and Compute

41. Open the Profile Plot and select Plans... from the Options Menu.

42.Check on both plans to display them simultaneously.

Plan Selection

i~ Plan Geometry and Results Comparison
[ Compare Geometry as well as Cmtput {can only select current plan + one more)

Mote: Geometry comparison only works for cross section and profile plots

Select Plans (current plan = PMF-Event FS 0001
[v|PMFEvent (Short ID = PMF-Event Geom = Existing Conditio
VI PMF-Event FS_0001 (Short ID = PMF-Event FS_0001
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Question: What is the largest difference in maximum water surface
elevations between the two plans? Where does this occur?

Question: Do you think this is a good location for a downstream
boundary condition? Why or why not?
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